
Kurzweil 3000 Version 12 

Web Licensing: Instructional Process

Web Licensing (V12 with VPORT): 
  
Teachers can now:  

� Create Kurzweil 3000 Assignments and save to a 

� Publish and Assign work to students

� View reports of individual and whole class usage and performance via the VPORT  Online Data 
Management System 

Anytime, anywhere access to a 
Internet access and Kurzweil 3000 Web License clien t installed.

o YES! That means that Students and Teachers can have access to Kurzweil 3000 at HOME!

� Personal preferences roam with the user. 

o This is NOT a web application.  It

� Kurzweil 3000 Web License Client CD is installed on each computer.  

o Access is limited to number of licenses owned.  

Files can now be saved to and opened from
secure file repository hosted by Kurzweil Education al Systems

  
o Files won’t take up space on your computers! 

o Files can be easily shared across users, schools, districts, etc. 

 Assignments & Reporting

o Teachers can now create and assign work to students from within Kurzweil 3000.

o Students can now easily complete and turn in their assignments 

o Teachers and Administrators can view reports on student performance

� Scores on assignments
� Student 
� MORE reports will routinely become available online via VPORT

Kurzweil 3000 Version 12 Web License 

Web Licensing: Instructional Process

  

Web Licensing (V12 with VPORT):  

Create Kurzweil 3000 Assignments and save to a central location 

Publish and Assign work to students and monitor progress 

reports of individual and whole class usage and performance via the VPORT  Online Data 

Anytime, anywhere access to a Kurzweil 3000 license via the web, from any compute r with 
Internet access and Kurzweil 3000 Web License clien t installed.    

That means that Students and Teachers can have access to Kurzweil 3000 at HOME!

Personal preferences roam with the user.  

This is NOT a web application.  It is a web license.   

Kurzweil 3000 Web License Client CD is installed on each computer.  

Access is limited to number of licenses owned.   

to and opened from  the “Web Universal Library”  –
secure file repository hosted by Kurzweil Education al Systems .  

Files won’t take up space on your computers!  

Files can be easily shared across users, schools, districts, etc.  

& Reporting  

Teachers can now create and assign work to students from within Kurzweil 3000.

Students can now easily complete and turn in their assignments  

Administrators can view reports on student performance 

Scores on assignments 
Student and teacher usage data  
MORE reports will routinely become available online via VPORT 

 

reports of individual and whole class usage and performance via the VPORT  Online Data 

Kurzweil 3000 license via the web, from any compute r with 

That means that Students and Teachers can have access to Kurzweil 3000 at HOME!  

Kurzweil 3000 Web License Client CD is installed on each computer.   

– a shared, 

Teachers can now create and assign work to students from within Kurzweil 3000. 

 



Web Licensing: Reporting

 

 

Licenses are managed via the VPORT Online Data Mana gement System. 

• To use Kurzweil 3000, you must have a VPORT registr ation.     

o A Unique User Login is required for every user via registration with VPORT. 

o An “Account Set-Up” form must be completed before your Kurzweil 3000 V12 Web 
License order is processed.  

o Your administrator will receive a “Welcome Package” via email from our Customer 
Service Department with instructions.  

o Your District Administrator  or Principal must provide you (the teacher) with your 
unique user name and password.  The District Admini strator or Principal also sets 
up all classes.   

� As a “teacher” you can set up the students in your class(es) by selecting from 
existing students in the database or creating new ones.   

        VPORT User Role privilege Hierarchy – Descr iptions: 

� District Administrator  privilege is needed to set up schools, principals, 
campus coach, classes, teachers, students 

� Principal privilege  is needed  set up teachers, Campus Coach, classes, 
and students 

� Teacher privilege  is needed to set up students.   (Teachers MUST have 
at least one class in order to create students, assign work to students in 
that class and view reports.) 

� Student privilege  only has access to their own information. 
� Campus Coach  can set up students and classes  and access multiple 

classes (perfect for AT specialists, inclusion facilitators, resource room 
educators, etc.)  
NOTE:  Principals and Administrators will not see the “assignment” icon 
when logged in to Kurzweil 3000. That is available in Teacher and 
Student view only.  



o Ongoing use of the VPORT Assignment, Reporting and File Storage services will require 
a yearly maintenance fee. You can still use Kurzweil 3000 without these services.  (Ask 
your Sales Representative for more details.) 

                      

Web Licensing: Benefits

Increases productive time on task:
• Enables anytime, anywhere learning

• Provides consistent user settings, documents, assignments

Enhances instruction:
• Makes time more efficient and effective

• Organizes documents, assignments, reports
• Informs data-based decision making

• Enables increasingly individualized instruction

Maximizes return on investment:
• Monitor usage to best deploy 

support
• Track student progress

 

 

 

Resources  available to support you in your use of Kurzweil 
3000 Web License with VPORT: 

• Videos www.youtube.com/user/cambiumtech  
• V12 Web License Datasheet 
• Kurzweil 3000 V12 Web License with VPORT User Guide 
• Kurzweil 3000 for Windows V12 Web License Guide 
• Kurzweil 3000 V12 Web License Account Set Up Form 
• Once logged-in to VPORT, you will have access to all of these resources and 

more available for viewing and download.  Just click on the “Support” tab in 
VPORT.  

• Cambium Learning Technologies Teams: 
o Customer Service 
o Technical Support 
o Sales Executives 
o Implementation Services 

 

 
 
 
 
 



 
 
 

 

Hands- On Activity:  Kurzweil 3000 V12 Web License with VP ORT 
Teacher Activity: Setting up Students and Creating Assignments

1.  Login -in as a Teacher:  
 
With V12 Weblicense, you should notice the 
assignment icon at the top left of your screen. 
 
You will need to use your VPORT User Name and 
Password. 
 
Notice that you can select the “License Type” for 
Kurzweil 3000 

• Color Professional 
• Black & White Professional 
• LearnStation 

 
NOTE:  You can also login to VPORT directly from the 

VPORT website: www.voyagerlearning.com
2.  Set up a Student(s) in your class:  
 

1. Go to Assignment  pull-down menu and select 
“Class Management” 

2. Select a class  
(NOTE: Only the District Administrator
Principal or Campus Coach has the privilege 
level to set up classes.)  
 
 

3. VPORT will automatically open
 
 
 
 
 
 

 
 

4. Click on the “Add Students” icon to 
students to your class 
 
 

5. Add a NEW student to VPORT 
 

6. Type in Last Name, User Name, ID, etc. 
(Repeat to add additional students.)
 

7. Always be sure to “save changes
 
NOTE: If your students are already registered in 
VPORT, you can select and find students by typing in 
the first few letters of their first or last name:

On Activity:  Kurzweil 3000 V12 Web License with VP ORT 
Teacher Activity: Setting up Students and Creating Assignments

, you should notice the 
assignment icon at the top left of your screen.  

You will need to use your VPORT User Name and 

Notice that you can select the “License Type” for 

NOTE:  You can also login to VPORT directly from the 
www.voyagerlearning.com  

 

 

 

 

down menu and select 

(NOTE: Only the District Administrator, 
has the privilege 

VPORT will automatically open 

Click on the “Add Students” icon to Add 

to VPORT  

Type in Last Name, User Name, ID, etc. 
(Repeat to add additional students.) 

save changes”  

NOTE: If your students are already registered in 
VPORT, you can select and find students by typing in 

first or last name:  

 

 

 
 

 
 
 

  
 

On Activity:  Kurzweil 3000 V12 Web License with VP ORT  
Teacher Activity: Setting up Students and Creating Assignments  

 

 

 



 
 

       8.  Click  “Return to Roster” to view student(s) Note 
the User Name and Password Created:_____________

3.  Create an Assignment  
 

1. Open a .kes file  
( “Time Travel.kes” from your “sample 
documents” folder  OR  one of your own .kes 
files from any location.) 

 
 
NOTE: Multiple Choice, True False and Matching 
Bubble Note questions are scorable with VPORT. 
Questions must have a SINGLE answer to be scorable. 
 
 

2. Embed three (or more) Bubble Note 
Questions 
If you have not added the Bubble note icon to 
your toolbar, you can access from: 
       Tools->Note->Add Bubble Note
 
 
 
 
Select Possible “Question Options” or “types”:

a. Multiple Choice 
b. True/False 
c. Matching 

 
For each question: 
1. Select “Question Option” type

(Use the red “up/down” arrows to add or 
subtract possible answers) 
 
2. In the spaces provided, type:

• Title(Optional) 
• Question 
• Possible Answers 

              3. Indicate the correct answer(s) to the 
                  Question(s).  
NOTE: When published to the Web Universal Library, 
the answers will be removed from the student’s view. 
              4.  Click “OK”   

8.  Click  “Return to Roster” to view student(s) Note 
the User Name and Password Created:_____________ 

 

 
 

from your “sample 
documents” folder  OR  one of your own .kes 

Multiple Choice, True False and Matching 
with VPORT. 

Questions must have a SINGLE answer to be scorable.  

more) Bubble Note 

If you have not added the Bubble note icon to 
your toolbar, you can access from:  

>Add Bubble Note 

Select Possible “Question Options” or “types”: 

Select “Question Option” type 

 
“up/down” arrows to add or 

2. In the spaces provided, type: 

3. Indicate the correct answer(s) to the  

NOTE: When published to the Web Universal Library, 
the answers will be removed from the student’s view.  

 
 
 
 
 

     OR          
 
 
 
Multiple Choice: 

 
True/False: 

 

 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
     4. SAVE the document to the 
         Web Universal Library .  
 

File->Save to Library  
 
Notice that you can create folders within your library to 
better organize your files. 

 
Save to YOUR folder.  If you save to the Public folder, 
others will see the file.   
The public folder is a good place to save files that you 
would like others to access.  
Students can NOT access the files in other student 
folders.   
Teachers CAN access files in student folders. 
 
 
Once saved to the “Library”, this document will be 
available to the User from WHEREVER the user
in.  The file is saved “in the cloud”.  
 
     5.  Publish  Assignment to                          
         Web Universal Library 
 
                 1.  File ->Publish 
 
Files MUST be Published  in order to later 
them to a student.    
Files can not be modified once published.
You can publish any Kurzweil 3000 supported 
document types. 
  
 
  
 
 
 
                 2. Follow prompts to review     
                     the first question and the “
                     several questions.  When done 
                     click “OK”  

 

Notice that you can create folders within your library to 

Save to YOUR folder.  If you save to the Public folder, 

The public folder is a good place to save files that you 

Students can NOT access the files in other student 

Teachers CAN access files in student folders.  

Once saved to the “Library”, this document will be 
from WHEREVER the user logs 

 
Matching: 

 

 

Assignment to                           

later assign  

be modified once published. 
You can publish any Kurzweil 3000 supported 

2. Follow prompts to review      
the first question and the “next”  
several questions.  When done  

 
 

 

 

 



         
 
 
 
 
 
 
                 3. Provide Information about the   
                     published Document  

• Title 
• Description 
• Tags (Great for searching for 

documents!) 
 
                 4.  Click “OK”.  You will automatically be   
                      connected to the “published” 
                      folder of the Web Universal 
                      Library.  Create new folder if 
                      needed or browse to desired 
                      folder and click “save”.  

6. Assign the Assignment to a student(s)
1. Click Assignment Menu -> New Assignment
 
(NOTE: “My Assignment List” will allow you to 
view ALL Current, Past and Future 
assignments.) 
 
 
 
 
 
 
 
 
 
 
 
 
2.  The “New Assignment” Dialog box will 
open.  
Use this dialog box to enter the following:

1. Title 
2. Description 
3. Tags (Optional) 
4. Response Type,  

Select: “Answers” when assigning a 
“Scorable assignment”
 
 
 
 
 
 
 
 
 
 
 

3. Provide Information about the    

Tags (Great for searching for 

4.  Click “OK”.  You will automatically be    
connected to the “published”  
folder of the Web Universal  
Library.  Create new folder if  

eeded or browse to desired  

6. Assign the Assignment to a student(s)  
> New Assignment 

“My Assignment List” will allow you to 
view ALL Current, Past and Future 

2.  The “New Assignment” Dialog box will 

Use this dialog box to enter the following: 

Select: “Answers” when assigning a 
“Scorable assignment” 

 
 
New Assignment Dialog Box: 
 

 

 



 
 
 
 
 
 
 

 
 

5. “Add Document”  to select file(s) 
from the “Published”
 
NOTE: Published documents do not 
have to be scorable. You can also 
publish written response documents, 
typical test documents with fill in the 
blank, a document to just “read”, a 
column note assignment, etc.  You 
will be able to assign and monitor 
but these documents will not be 
scored.  
 

Can you think of documents you might like to assign to 
your students?  
 
 
 

6. Click “Add Student” to assign to a 
student in your class. 

o Select Student(s)
o Select Assignment Begin 

and End Dates
 

7. Click “OK” 
 

to select file(s) 
Published”  folder. 

NOTE: Published documents do not 
. You can also 

publish written response documents, 
typical test documents with fill in the 
blank, a document to just “read”, a 
column note assignment, etc.  You 
will be able to assign and monitor – 
but these documents will not be 

documents you might like to assign to 

Click “Add Student” to assign to a 
student in your class.  

Select Student(s) 
Select Assignment Begin 
and End Dates 

 
Selecting from files(s) “Published” folder:
 

 

 

folder:  

 

 



 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Hands-On Activity:  Kurzweil 3000 V12 Web License w ith VPORT  
Teacher Activity: Student View – Completing an Assi gnment 

 
1. Login as a Student  
Use the User Name and Password of the student 
you created.  
 
“My Assignment List” dialog box will 
immediately pop-up to alert students to their 
assignments.  

 

 
 

 
6. Log-Out of Kurzweil 3000 
 

 
 



 
 

1. Click on any assignment to select it. 
Double Click on Assignment to view 
it OR Click on “view 

 
 
 

2. Click on the assignment document 
to open it and begin. 
 

 
 
 
 
 
 
 

2. Complete the Assignment
 

3. The Assignment toolbar will open 
allowing a student to:

a. Open Assignment
b. Open response document 

(if applicable)
c. Save assignment
d. Close assignment
e. Submit assignment

 
 

4. Visit the “Assignments
menu to look at options.

a. Note that you can 
Teacher a Question
an assignment or select 
“My Assignment List” 
view current and past 
assignments.

 
 
 
 
 
 
 
 
 

5. Ask a Question 
 

Click on any assignment to select it. 
ble Click on Assignment to view 

Click on “view assignment”  

Click on the assignment document 
to open it and begin.  

 
 
 
 

 
2. Complete the Assignment  

The Assignment toolbar will open 
allowing a student to: 

Open Assignment 
Open response document 
(if applicable) 
Save assignment 

assignment 
Submit assignment 

“Assignments ” pulldown 
menu to look at options. 

Note that you can Ask the 
Teacher a Question  about 
an assignment or select 
“My Assignment List” to 
view current and past 
assignments. 

 
 
 
 
 

 
 
 
 

 
 

 

 

 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
6. Answer the Bubble note questions  

(You created them as a “teacher”.)
 
 
 
 
 
 
 
 
 
 
 
 
 

7. Lookup some words using the 
Digital DictionaryTool.
 
 

 
 
 
 

8. Submit the Assignment
 
 
      
   

5. Logout of Kurzweil 3000  
 
 
 
 
 
 
 
 
 
 
 
 
 

Answer the Bubble note questions  
(You created them as a “teacher”.)  

Lookup some words using the 
Digital DictionaryTool. 

the Assignment 

 
 
 

 
 
Dictionary Tool: 

 
 
 
Submit Tool: 

 
 

 

 



Hands- On Activity:  Kurzweil 3000 V12 Web License with VP ORT 
Teacher Activity: Monitoring Assignments 

1. Login as a Teacher  to view assignment(s) 
received from student(s) 
 
 
 
2. To View your Assignments for students,

 
1. Select:   
Assignments->My Assignment List
 
 
 
 
 
 
 
 
 
2. Click on “Student Info” tab to view 
status of selected Assignment. 
 
 
3.  Accept the assignment.
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
4. Respond to any student “requests” 
and “Send”.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

On Activity:  Kurzweil 3000 V12 Web License with VP ORT 
Teacher Activity: Monitoring Assignments  

 
to view assignment(s)  

2. To View your Assignments for students,  

>My Assignment List 

2. Click on “Student Info” tab to view 
status of selected Assignment.  

3.  Accept the assignment. 

4. Respond to any student “requests” 

 

 
 

 

On Activity:  Kurzweil 3000 V12 Web License with VP ORT  

 



5.  Click “OK” to finish viewing 
assignments.  

 

Hands- On Activity:  Kurzweil 3000 V12 Web License with VP ORT 
Teacher Activity: Viewing Reports 

 
1. Viewing  Reports 
      1. From within Kurzweil 3000: 
 

Click:  
Assignments pulldown menu
ClassReporting ->select desired 
class 

5.  Click “OK” to finish viewing 

 
 

On Activity:  Kurzweil 3000 V12 Web License with VP ORT 
Teacher Activity: Viewing Reports  

1. From within Kurzweil 3000:  

pulldown menu-> 
>select desired 

 
 

 

On Activity:  Kurzweil 3000 V12 Web License with VP ORT  



 
 
 

 
       2.  VPORT will open in your web 
            browser.    
           From here, you can fully access 
           VPORT and view reports, 
           manage your class, access 
           support, etc .  
 
 
 
 
       3. Click on the“My Results”
           Notice the Reports currently 
           available: 

• Dashboard 
• Usage 
• Assignments 
• Word Lookup 
• AND MORE TO COME!

 
 
 
 
 
 
 
 
 
 
 
 
 
      4.  Explore the Dashboard, Usage, 
           Assignments and Word Lookup 
          Tabs.  Notice the ability to filter 
           reports.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2.  VPORT will open in your web  

fully access  
reports,  

class, access  

“My Results” Tab.    
Notice the Reports currently  

AND MORE TO COME! 

4.  Explore the Dashboard, Usage,  
Assignments and Word Lookup  

Tabs.  Notice the ability to filter  

 
 
 
 

 
Dashboard Report: Usage and Assignments at a glance

 
 

 
 

Student Usage Report

 
 
 
 

 
Student Response Report: 
NOTE: Each part of a “Matching” question is regarded as one 
question.  

 

 

 

Dashboard Report: Usage and Assignments at a glance  

 

Report  

 

NOTE: Each part of a “Matching” question is regarded as one 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5.  Things to think about. 
would each report be useful to a 
teacher? A principal? An 
administrator? 
 
 
 
6. Logout of Kurzweil 3000 
VPORT.  

 
 
 
 
 

 

 

5.  Things to think about. How 
would each report be useful to a 
teacher? A principal? An 

6. Logout of Kurzweil 3000 and 

 
Word Lookup Report: 

 
 
 
 
NOTE:  Administrators will have access to
student data.  They will be able to view Kurzweil 3 000 use 
by School, teacher, student, etc.   How powerful!!

 

 

 

 

 

  

 

 

Administrators will have access to  more than just 
student data.  They will be able to view Kurzweil 3 000 use 
by School, teacher, student, etc.   How powerful!!  


